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ABSTRACT

Criticality safety analyses often require detailed modeling of complex geometries. Effective 
visualization tools can enhance checking the accuracy of these models. This report describes 
the KENO3D visualization tool developed at the Oak Ridge National Laboratory (ORNL) to 
provide visualization of KENO V.a and KENO-VI criticality safety models. The development 
of KENO3D is part of the current efforts to enhance the SCALE (Standardized Computer 
Analyses for Licensing Evaluations) computer software system.
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1 INTRODUCTION

The SCALE (Standardized Computer Analyses for Licensing Evaluations) computer software 
system' developed at Oak Ridge National Laboratory (ORNL) is widely used and accepted 
around the world for criticality safety analyses. SCALE includes the well-known KENO V.a 
and KENO-VI three-dimensional (3-D) Monte Carlo criticality computer codes. Criticality 
safety analyses often require detailed modeling of complex geometries. Effective 
visualization tools can enhance checking the accuracy of these models. To address this need, 
ORNL has recently developed a powerful state-of-the-art visualization tool called KENO3D.  
The purpose of this report is to describe the KENO3D visualization tool.
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2 KENO3D OVERVIEW

KENO3D enables KENO V.a and KENO-VI users to interactively display their three-dimensional geometry models. The interactive options include: 

* Shaded or wireframe images 
* Standard views, such as top view, side view, front view, and isometric (3-D) view 
* Rotating the model 
* Zooming in on selected locations 
* Selecting parts of the model to display 
* Editing colors and displaying legends 
* Displaying properties of any unit in the model 
* Creating cutaway views 
* Removing units from the model 
* Printing image or saving image to common graphics formats 

KENO3D reads CSAS, KENO V.a, and KENO-VI input files. It attempts to verify that the KENO geometry input is "legal" (i.e., it conforms to the code input guidelines). KENO3D 
prints a warning message for illegal geometry input, and if possible, it displays the illegal KENO geometry to facilitate debugging of the input. Problems with more than 300,000 
KENO V.a bodies* have been successfully tested and displayed.  

KENO3D has the look and feel of a typical PC Windows application. Toolbar buttons are included for all major menu options. A setup dialog allows the user to specify toolbars that should be displayed. KENO3D has a fully integrated help system to aid beginning, as well as 
advanced users.  

KENO3D has several unique options that provide users with increased flexibility in visualizing portions of a model in greater detail or for visualizing parts of larger models that may be too big to provide a useful image when viewed in their entirety. These options 
include: 

* "Load slice" option allows the user to define a three-dimensional (3-D) slice to 
display prior to loading the model. The slice can be specified by defining the corners 
of a bounding box or by restricting the portion of an array in the model.  

0 A variety of cutting tools allows the user to remove sections from the model to view 
the internal structure. A "remove section" option allows the user to remove a block or pie shaped section from the model. Another cut-tool is an interactive block eraser.  
The user drags the eraser to the desired location by holding down the left mouse button, and then double clicks the left mouse button to remove the part of the model 
under the eraser. A sample KENO3D model visualization using the cutting tools is 
shown in Figure 1.  

"In general, a body in KENO3D is equivalent to a geometry region in KENO.  
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KENO3D Overview

" Using the "rebuild in window" option, the user can draw a window around a portion 
of the model in the view. KENO3D will then reload the model, displaying only the 
portion that is in the window. This option is useful when displaying smaller parts of a 
complicated model.  

" The user may use nesting level control to reduce the amount of detail in the model by 
setting the nesting level for arrays and holes to a small value such as zero or 1, 
depending on the model. With a nesting level of zero, no holes or arrays are filled. If 
nesting level is 1, only the first level of arrays and holes are filled, etc. A 
recommended strategy is to load the model with a nesting level of zero, make cuts, 
adjust the view to desired zoom level and orientation, change the nesting level, and 
then reload the model Though for a large model the execution time can be significant, 
the majority of interactive steps occur in the first few seconds. With care, the reloaded 
model requires little or no interactive changes.

Figure 1 KENO3D sample LWR shipping container

NUREG/CR-6662 4
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3 TOOLBARS

There are eight toolbars by default at startup. All toolbars can be docked (the default), moved 
to any location on the screen, or hidden from view. On exit, KENO3D saves the present 
configuration in an initialization file. Toolbar positions and other settings will be restored 
from the initialization file the next time KENO3D is executed. The toolbars and their 
functionality are described below.  

3.1 STANDARD TOOLBAR 

The standard toolbar contains seven buttons. Five of the toolbar buttons are related to loading 
the model.  

.... Open File. This button is the same as the "Open" option under the File menu.  
The active folder will be opened, and a file dialog box will allow the user to select the 
appropriate input file to display. For very large problems or problems that the user is not 
familiar with, simply opening the file can result in excessive execution time.  
"Preloading" may be safer when dealing with large problems.  

[-I Preload File. This button is the same as the "Preload" option under the File 
menu. The user may select a file to "Preload." The file will be opened and the input read 
without displaying the model. After preloading, the user may display information about 
the model, select a unit to load, mark mixtures for hiding, or load a model slice. This 
method is the preferred way to open large input files or input files for new models.  

[ Reload Active File From Disk. The file in the active window will be 
reloaded by rereading the. input file. Reload rereads the model input from disk. For 
example, the user may select this option if the input file has changed, or if the user 
wishes to reset everything to the initial state.  

N Custom Reload From KENO3D Memory. A list of KENO units in the 
active file is presented. The user may select any unit from this list to display. The file 
on disk is not reread. The user may change the nesting level. This option may be 
used after a "Preload File." For example, the user may use this option to "load" a 
model at a low nesting level (e.g., 0), then make several cuts. Once the model has had 
sections removed, the user may select to reload the model at a higher nesting level.

NUREG/CR-66625
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Load Slice. A list of KENO units in the active file is presented. The user may 

select any unit from this list to display. The user may define a "'slice" of the model to 

display by specifying model bounds or array bounds. The dialog presented allows the 

user to mark mixtures to hide. With the "bound model" option, the user may also specify 

a portion of the model to be removed (e.g., front quarter, pie slice, etc.) The user may 

change the nesting level. The file on disk is not reread.  

11Print File. A print file dialog is started. The display of the active file may be 
printed.  

M- Copy Screen to Clipboard. Clicking this button causes the image in the 

active KENO3D window to be copied to the clipboard. The contents of the clipboard 

may be pasted into other applications (e.g., Word, Paint, WordPerfect, etc.) 

3.2 VIEWS TOOLBAR 

The Views Toolbar contains four buttons.  

.... Isometric (3D) View. The active model is displayed in an isometric or 

3-dimensional view.  

SITop View. The active model is displayed from the top.  

I Right View. The active model is displayed from the right.  

LIFront View. The active model is displayed from the front.  

3.3 ZOOM TOOLBAR 

The Zoom Toolbar contains five buttons.
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Section 3 Toolbars 

N Zoom All. The active model is zoomed to fill the window.  

12 Zoom Window. The user draws a window around a portion of the model by 

dragging the mouse while holding the left button down. The window is complete 
when the user releases the left button. Clicking the left button again will cause that 
portion of the model that is contained in the window to be zoomed into full view.  

. Zoom Using Mouse. The active model can be zoomed in or out by holding down 
the left mouse button, and dragging the mouse up or down.  

1 Zoom-in. The active model is zoomed in to approximately 200% of its present 
size.  

Zoom-out. The active model is zoomed out to approximately 50% of its present 
size.  

3.4 CAMERA TOOLBAR 

The Camera Toolbar contains three buttons.  

N .. Orbit Camera. The "camera or view position" can be orbited around the active 
model by holding down the left mouse button and dragging the mouse.  

[A+ Pan Camera. The view position for the active model can be panned left or right 
by holding down the left mouse button while dragging the mouse.  

IM Rotate View. This menu button causes the Rotate View Around Axis Toolbar 
to pop up.
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Section 3
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3.5 ROTATE VIEW AROUND AXIS

The Rotate View Around Axis Toolbar does not show up by default; however, the user may 

choose to leave this toolbar active. This toolbar becomes active by clicking the Rotate View 

button on the Camera Toolbar. This toolbar may also be docked.  

Rotate View Around X-Axis. The view position for the active model can be 

rotated around the x-axis by holding down the left mouse button while dragging the 

mouse. 

FIK I Rotate View Around Y-Axis. The view position for the active model can be 

rotated around the y-axis by holding down the left mouse button while dragging the 

mouse.  

__ Rotate View Around Z-Axis. The view position for the active model can be 

rotated around the z-axis by holding down the left mouse button while dragging the 

mouse.  

Ii1 Step. The STEP button allows the user to set the size for incremental 

rotations. The view position can be rotated incrementally by selecting one of the 
"rotate view" buttons, holding down the control key or shift key, and clicking the left 

mouse button.  

3.6 DISPLAY PROPERTIES/IUDE OBJECTS TOOLBAR 

The Display Properties/Hide Objects Toolbar contains three buttons.

8NUREG/CR-6662



[12 Display Properties. The user may click on selected model parts using the left 
mouse button to display information about the selected part (e.g., mixture, unit, 
composition, etc.). The dialog will allow the user to hide the selected entity, mixture, 
or unit items.  

N• Erase Mixture. Clicking this button will display a list of mixtures in the active 
model. The user may select a mixture to hide from the view.  

I9 Display Model Properties. A click on this button will display information about 
the model presently in the active view.  

3.7 DISPLAY OPTIONS TOOLBAR 

The Display Options Toolbar contains four buttons.  

•] Shaded Image. The active model is displayed as a shaded image.  

LM Wireframe Image. The active model is displayed as a wirefirame.  

n Highlight Edges. The active model is displayed as a shaded image with edges 

highlighted. Clicking this button will toggle edge highlighting on or off.  

Refresh Wireframe. Clicking this button will cause the wireframe to be 
reconstructed at the present zoom level. For example, a very small image of a 
cylinder might actually be displayed as a hexagon. After zooming, refreshing will 
cause KENO3D to recalculate the vertices, possibly displaying a smoother wireframe 
image.  

3.8 LEGEND AND AXIS OPTIONS TOOLBAR 

The Legend and Axis Options Toolbar contains three buttons.

NUREG/CR-6662
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S! Color Legend. The user is presented a dialog box showing the various color 

legend options. A color legend may be presented in the active view or in a separate 
view. If the user wishes to edit colors, the legend must be in a separate view.  

M Light Intensity. By clicking this button, a light-intensity dialog box is presented 
that allows the user to adjust the intensity of eye, distant, and ambient light sources.  

Display-axes. This button will toggle the axes on/off. If the axes are not 
showing in the active view, the user is presented a dialog box showing the various 
axes options. If the axes are active, clicking this button will remove the axes from the 
active view.  

3.9 CUTAWAY VIEWS TOOLBAR 

The Cutaway Views Toolbar contains three buttons.  

__ Interactive Eraser. The model is switched to wireframe. A red, rectangular 

eraser is shown in the view. The user may drag this eraser to any position. Double 
clicking the mouse will remove the portion of the model inside the red wireframe.  
The user may change views during this operation. When satisfied with the position of 
the eraser, double clicking the mouse will invoke the removal operation. The 
operation may be cancelled by reclicking the Interactive Eraser button.  

M . Remove Section. The user is presented a dialog box showing the various 
"slicing" options. Slicing options that specify the shape and location of the section to 
be hidden from view include pie, quarter, top, right, front, left, back, and bottom.  

1I Rebuild In Window. The user defines a plane, such as an x-y plane. The 
third plane is considered infinite. The user draws a rectangle around a region of the 
model by depressing the left mouse button and dragging the mouse. The rectangle is 
complete when the left mouse button is released. Clicking the left mouse button again 
will cause KENO3D to reload the model from the file and build only the portion that 
falls within the window. The user may cancel this operation by reclicking the 
"Rebuild In Window" button any time prior to the final mouse click.

NUREG/CR-6662
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4 THE MENUS 

Six pull-down menus are below the title bar of the main window, with corresponding toolbar buttons for most of the menu options. Prior to loading a model, only three menus are shown 
(e.g., File, Setup, and Help).  

4.1 FILE MENU

0 

0 

0 

0

Open 
Close 
Preload File 
Reload File 
Save As Picture 
Print, Print Setup 
Print Preview 
Recent Files 
Exit

Most of these are self-explanatory. Save As Picture allows saving the screen image in a Windows Metafile Format for import to other applications such as Word, WordPerfect, etc.  
Preload allows a file to be opened and the input read without displaying the model. After preloading, the user may display information about the model, select a unit to load, mark 
mixtures for hiding, or load a model slice.  

4.2 VIEW MENU

" Standard Views 
- Isometric (3-D) 
- Top 
- Right 
- Front 
- Bottom 
- Back 
- Left 

" Select 
- Unit From Memory 
- Display Properties 
- Erase Mixture 
- Pick Body To Erase

* Camera 
- Orbit 
- Rotate 
- Pan 
- Zoom Window 
- Zoom All 
- Zoom Mouse 
- Zoom In 
- Zoom Out 

* Cutouts 
- Remove Section 
- Interactive Eraser 
- Rebuild In Window

NUREG/CR-666211
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Section 4 

The View Menu also contains the following selections: 

"• Set Lights. By clicking this option, a light-intensity dialog box is presented that 

allows the user to adjust the intensity of eye, distant, and ambient light sources.  

"* Shade. The active model is displayed as a shaded image.  

"• Highlight Entities. The active model is displayed as a shaded image with edges 

highlighted. Selecting this option will toggle edge highlighting on or off.  

"• Wireframe. The active model is displayed as a wirefiame.  

" Refresh. Selecting this option will cause the wireframe to be reconstructed at the present 

zoom level. For example, a very small image of a cylinder might actually be displayed 

as a hexagon. After zooming, refreshing will cause KENO3D to recalculate the vertices, 

possibly displaying a smoother wireframe image.  

" Add Legend. The user is presented a dialog box showing the various color legend 

options.  

"• Show Axes. This option will toggle the axes on/off. If the axes are not shown in the 

active view, the user is presented a dialog box showing the various axes options. If 

the axes are displayed, clicking this option will remove the axes from the active view.  

" Display Properties. The user may click on selected model parts using the left mouse 

button to display information about the selected part (e.g., mixture, unit, composition, 

etc.). The dialog will allow the user to hide the selected entity, mixture, or unit items.  

" Hide Mixture. The user is presented a list of mixtures in the active model. The user 

may select a mixture to hide from the view.  

"* Display Model Properties. Information is displayed about the model presently in the 

active view.  

" Custom Reload. A list of KENO units in the active file is presented. The user may 

select any unit from this list to display. The file on disk is not reread. The user may 

change the nesting level.  

" Load Slice. A list of KENO units in the active file is presented. The user may select 

any unit from this list to display. The user may define a "slice" of the model to 

display by specifying model bounds or array bounds. The dialog presented allows the 

user to mark mixtures to hide. With the "bound model" option, the user may also 

specify a portion of the model to be removed (e.g., front quarter, pie slice, etc.) The 

user may change the nesting level. The file on disk is not reread.

NUREG/CR-6662 12



Section 4 The Menus 

4.3 WINDOW MENU 

" New Window makes a copy of the active window, which can allow the user to have 
multiple views of the active model. For example, the view can be changed from 
isometric to top view in the active window. However, any changes to the active model, 
such as a cutaway or reload, will be reflected in all windows showing the active model.  

" Cascade presents all model windows in a hierarchical order.  

" Tile "tiles" all model windows.  

4.4 SETUP MENU 

The Setup Menu allows the user to change background color, toolbar settings, optimization 
level, interactive options, and CSAS options. Changes can be made permanent or temporary.  
A "Reset Defaults" button will reset all setup options to the original installation settings.  

4.5 EDIT MENU 

The Edit Menu contains three options.  

" Copy to Clipboard option copies the active window to the clipboard for importing to 
other applications, such as commercial word processing and graphics software programs.  
After selecting this option, and changing to another application, the paste command in 

the other application can be used to copy the image of the active window into that 
application.  

"* Edit File opens the CSAS or KENO input file for editing with a user-specified text 
editor.  

"* Editor Setup provides a dialog that allows the user to specify their preferred text editor.  

4.6 HELP MENU 

The help menu provides online guidance in the use of KENO3D. Two options are available: 

"* Help Topics starts the fully integrated KENO3D help system. KENO3D help is an 
embedded HTML Help application with a table of contents, index, and search 
capabilities.  

"* About KENO3D displays the version number of the software and copyright information.
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5 SMALL MODEL EXAMPLE

Using KENO3D to visualize models with less than 400 bodies is relatively easy to do with the 
default settings. The example demonstrated comes from the KENO V.a user manual and is 
included in the KENO3D distribution package as 'kenol2.inp." To run this problem with 
KENO3D: 

1. Start KENO3D 
2. Click the file menu 
3. Click Open 
4. Move to the folder that contains the KENO V.a examples (i.e., 

C:\KENO3D\Examples), and select the file (i.e., kenol2.inp).  
5. Click the Open push button.  

6. Use the 'Erase Mixture" option to remove mixture zero.  

7. Click on 'Remove Section" followed by "OK" to get the resulting image 
shown in Figure 2.

Figure 2 Simple KENO V.a example

NUREG/CR-666215



6 LARGE MODEL EXAMPLE

Though it is possible to load models with many thousands of bodies, the resulting image may be of limited usefulness. Often the amount of detail is far greater than the resolution of the screen. Also, due to the number of bodies in the image, the interactive behavior of KENO3D 
may be very sluggish. Depending on the characteristics of a model, the user may choose a variety of ways to load a view of the model. Loading a very large model may take 20 to 30 minutes of execution time, or more, using the "Open File" button. Getting a slice of the same model, with some mixtures removed, might be achieved in 20 to 30 seconds using "Preload File" followed by "Load Slice" Warning: when a model slice intersects a majority of the objects in the model, loading a slice can also be very resource intensive (i.e., memory and time). To work effectively the user should try to specify a slice that significantly reduces the number of objects that will ultimately be displayed. Some of the alternatives that may be useful in reducing the number of objects in the KENO3D display when working with larger 
models are the following: 

1. Use "Preload" to read the model input, then load selected units other than the global 
unit.  

2. Use "Preload" to read the model input, then use "Load slice" to reduce the number of 
bodies to be displayed.  

3. Reduce the model detail by setting the nesting level for holes and arrays to 1 or zero.  
With a nesting level of zero, units referenced in holes or arrays in the global unit are 
represented by a single body. With a nesting level of 1, units referenced in holes or arrays in the global unit are displayed; however, units referenced in holes or arrays in 
those units are represented by a single body.  

The example demonstrated has more than 280,000 bodies when modeled in full detail. The array in the global unit has 314 levels in the Z direction. This example is included in the KENO3D distribution package as "GA4-TruckCask.inp." To achieve the image shown in 
Figure 3: 

1. Load the model input using the "preload" option.  

2. [ Use "Load slice" to restrict the image displayed to be the array slice at the 76' 
Z level.  

3. N Mark mixtures zero (void) and water to be hidden from view.  

4. 1J Use "zoom window" to zoom in on a selected portion of the slice.
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Large Model Example Section 6

Figure 3 A zoomed-in slice of a large KENO V.a model with water and void hidden from view 
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7 SUMMARY

The primary objective in the development and ongoing enhancements to KENO3D is to provide an easy-to-use visualization tool that allows criticality safety specialists to interactively display their KENO V.a and KENO-VI geometry models. A production version of KENO3D for KENO V.a geometry models was released in 1999. KENO3D with enhancements to allow modeling of KENO-VI geometry models is to be released in 2000.
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